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1. Polygonal column 
 
WinAqua can be used for creating a polygonal column as shown on the 
Fig.1.1. 
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Fig. 1-1 Polygonal column 

 
The column is made of B25 concrete and the same is reinforced with 
standard reinforcement BST 420. The position of the reinforcement is 
shown on the Fig.1.2.  
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Fig. 1-2 Reinforcement placement 

  
Some previous preparations are necessary for creating column geometry in 
WinAqua. For example user should define the position of the coordinate 
beginning (0,0), the units in which the cross section will be entered, the 
coordinate of the points which define column contour, the points where the 
reinforcement is and the sections in which user would like to control the 
share stresses. 
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1.1. Previous preparations: 

Defining of the coordinate beginning and characteristic 
points of the cross section: 

Polygon column geometry will be described with six characteristic points 
(1,2,3,4,5 and 6) with which the contour of the column will be defined. User 
should define another five points with which the position of the single 
reinforcement will be defined. These are points 101,102,103,104 and 105 
shown on the Fig.1.4. The coordinates will be given in unit’s meters [m] 
from the SI system. The coordinates of the points from the cross section will 
be defined in relation with previously determined coordinate system. For 
this example the coordinate beginning will be taken as it is shown on 
Fig.1.3. The points with which we will define the cross section are shown on 
the Fig.1.4. 
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Fig. 1-3      Fig. 1-4 
The coordinates of the points with which the geometry of the column is 
defining are given in the Table 1.1, and the coordinates of the points with 
which the single reinforcement is defining are given in the Table 1.2 



 

WinAqua Version 10.21-99 8 

Table 1-1 Table 1-2 
 
 
 
 
 
 
 
 
 

 
 
 

1.2. Solving the problem with WinAqua 
 

1.2.1. Defining default units and materials in database file 
 

Form “Extras” menu  select command “Settings” to define the main input 
parameters of WinAqua for a new database.  

 

Coordinate Point Y Z 
1 0.000 0.000 
2 -0.400 0.000 
3 -0.550 -0.315 
4 -0.750 -0.315 
5 -0.750 -0.630 
6 0.000 -0.630 

Coordinate As Point Y Z cm2 

101 -0.105 -0.105 55.44 
102 -0.320 -0.077 36.96 
103 -0.673 -0.392 24.64 
104 -0.673 -0.525 36.96 
105 -0.105 -0.525 36.96 
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Option window will appear 

 
 

With “input units” user can define the units in which database file will be 
drawn. If user selects a button located under “input units” a new window will 
appear which will allow defining the main units for a database. 
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User can define: 
- Standard units of SI-System 
- General structural engineering (e.g. cm instead of m) 
- Steel construction, SI-System (e.g. mm instead of m) 
- Concrete bridge construction, SI-System (e.g. MN instead of kN) 
- Geo-techniques, SI-System (e.g. MN instead of kN) 
- Hydrology 
- Standard units of US-System 
- General structural engineering in US-System 
- Steel construction in US-System 
- Concrete bridge construction in US-System 
- Geo-techniques in US-System 
For this example user should select System SI, Standard mode so he can 
use standard units like m and kN for defining new database. 
 
User can define default materials, which will be included in the new 
database. This can be done with “Generation of default materials” options in 
a new database from option window. 

 
If the user selects “No default material” option then there will be no material 
input in the new database.  
If “Steel” option button is selected then WinAqua will automatically add only 
default steel material Structural steel 235 (DIN 18800). 
If “Steel + Concrete” option button is selected then WinAqua will 
automatically add default Standard reinforcement steel BST500 (DIN 1045) 
and standard concrete material B 25 (DIN 1045). 
If “Steel + Concrete + Brick” option button is selected then WinAqua will 
automatically add default Standard reinforcement steel BST500 (DIN 1045) 
, standard concrete material B 25 (DIN 1045) , standard structural steel 235 
(DIN 18800) and  brick MZ4 I (DIN 1053-1). 
For Example 1 user should select “Steel + Concrete”  
From the tab “color definition” user can define visual parameters such as 
type and color of the cross section lines, reinforcement lines, shear cut 
lines, text height etc. More detail information about tab “color definition” are 
given in Example 2 step 1 
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1.2.2. Creating a new database file, changing default 
materials  

 
From “File” menu select “New database”. 

 
WinAqua will open a new database file Untitled_1.cdb 
that will contain default materials previously defined in 
step 1. User can explore which materials are inputted in 
a new database file in a window database. By double 
clicking on a material in database window, user can 
change the default material and the designed code if is 
necessary. In this example it is not necessary to change 
concrete materials because B25 concrete shall be use 
for the polygon column. User should change only 
reinforcement steel because WinAqua added Standard 
reinforcement BST 500(default material). To change 
standard reinforcement user has to double click on a “2 
* BST 500” from database window. A new window will 

appear called “SOFiSTiK: Materials”. 
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This window will allow user to change standard reinforcement steel 
classification from 500 to 420. 

 
By pressing on the button OK WinAqua will change standard reinforcement 
steel from BST500 to BST420. 

 
1.2.3. Creating Section 

 
To create new section from the menu “Edit” select “New section [thick 
walled]…” or select icon      from “CDBase Toolbar”. 

                   
A new window will appear allowing user to define some global parameters 
for new cross section. 

 
Here user can define number of the cross section by which the cross 
section will be stored in a database, the name of a cross section (example: 
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Polygon column) and the material for cross section, reinforcement and 
stirrup. User can only select materials previously defined in step 2. Here the 
user can define a unit if that is not previously done in step 1. 
In a “Control values” tab the user can define some parameters such as:  
 
Shear stress model 
Default shear cut 
Mesh size for integral equations 

 
“Shear stress model” controls the computation of shear stresses in solid 
sections: 
1- force method 
2- displacement method only for It and location of shear center (default for 
concrete) 
3- displacement method for torsion, 
4- displacement method for torsion and shear, shear deformation areas are 
determined (default for steel, timber). 
Options 2 and 3 should be used for composite sections, but with caution. 
For more details see aqua manual 2.7. Shear Stresses in Solid Sections. 
 
“Default shear cut” allows the user to control how many of these standard 
cuts will be generated (0/1/2). The cut can hit the cross-section several 
times creating partial cuts. Each partial cut has a direction s and three 
defined points of interest: beginning (A), middle (M) and end (E): 
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The internal forces perpendicular to the cut M and N act in such way that 
positive axial forces cause tensile stresses, and positive moments cause 
tensile stresses at the End-Point. 
The shear stressing is described primary by the resistance module of the 
shear stresses at the three points. Additional values are calculated for the 
proportioning of reinforced concrete structural elements: 
A mean torsion shear stress which, after being multiplied by the width of the 
partial section, must be covered by reinforcement. This corresponds to a 
section modulus for the shear flow. 

• The total cut width, by which the shear stresses due to the shear 
force must be multiplied in order to obtain the shear flow from shear 
force. These distinctions are very significant in the definition of 
equivalent hollow cross-sections. 

“Mesh size for integral equations” controlled the fineness of the subdivision 
for the integral equation method. This indicates how large an element may 
be compared to the largest dimension of the cross-section. 
 
0 No subdivision 
1 maximum 1/2 
2 maximum 1/4 
3 maximum 1/8 
4 maximum 1/16 (default) 
By pressing the button “OK” a new item will appear in database window in 
the folder “Section”. 
 

 
Description: 
 
Icon  shows the user that he used “thick walled” section 
 
1 tells user that he selected No 1 for a cross section to be   stored in a 
database 
* tells user that the changes in a data base are still not saved 
! tells user that there is no calculated result for a cross section 
Pol.. tells user the name that he selected for a cross section No 1 
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On the right side a new drawing area will appear where user can draw 
section. In the right bottom of the drawing window WinAqua will show 
selected unit for drawing a section. 
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1.2.4. Drawing section 

 
With WinAqua a cross section can be drawn using the menu “Section” and 
all available options in this menu, or by using “Edit section” toolbar. 

 
  
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
Tools for drawing section can be divided in four groups: 
Groups for defining contour of the cross section, 
 

Icon Description 

 Contour 

 Circle contour 

 Polygonal hole 

 Circle hole 
 
Groups for defining reinforcement of the cross section, 
 

Icon Description 

 Single reinforcement 

 Line reinforcement 

 Circle reinforcement 

 Contour reinforcement 

 Steel shape 
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Groups for defining characteristic shear cut, non effective parts and stress 
point on a cross section, 
 

Icon Description 

 Shear cut 

 Non –effective part 

 Stress point 
 
Groups for defining help line for easier creating of cross section using on-
snap. 
 

Icon Description 

 Help Point 

 Help Line 

 Help Circle 
 
During the use of these commands it is necessary for user to pay attention 
on the command window in the bottom of the WinAqua window. Command 
window will be guide for correct use of all these commands. 
 

 
 

1.2.5. Description of the section drawing command  
(necessary for defining cross the section in Example 1) 

 

 Contour 
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After activating the command “Contour”, WinAqua will expect the user to 
define first and the last point of a contour of the cross section. Points can be 
added in the drawing by clicking with mouse on the drawing area or by 
typing y,z coordinates in the command window. The command will be active 
until closed polygon is created. By pressing escape, the command will be 
canceled and WinAqua will automatically create closed polygon by 
connecting the first input point with the last input point. 
For Example 1 user can activate command contour and can define cross 
section by inputting coordinates of six characteristic points of a cross 
section defined in Table 1.1 in the command bar 
 
Command: 
 
New Polygon, first point [m] 0,0 
New Polygon, next point [m] -0.4,0 
New Polygon, next point [m] -0.55,-0.315 
New Polygon, next point [m] -0.75,-0.315 
New Polygon, next point [m] -0.75,-0.63 
New Polygon, next point [m] -0.,-0.63 
[Press ESC to close the couture or press right mouse button and select 
Close command]  

 



 

WinAqua Version 10.21-99 19 

 
Another way to draw a section is by using local coordinate system instead 
of global. Local coordinate system is activated when in front of the y,z 
coordinates user puts sign “@”, then WinAqua will place the local 
coordinate system in the last input point in the drawing. 
 
Command: 
 
New Polygon, first point [m] 0,0 
New Polygon, next point [m] @-0.4,0 
New Polygon, next point [m] @-0.15,-0.315 
New Polygon, next point [m] @-0.20,0 
New Polygon, next point [m] @-0,-0.315 
New Polygon, next point [m] @0.75,0 
 
[Press ESC to close the couture or press right mouse button and select 
Close command]  
 
To define point name entered in a drawing, simply double click on a point 
that was drown. The first click with the mouse will select a point. The 
second click on the selected point will show “Polygon vertex” window where 
user can define name of the point, redefine it’s coordinates if necessary or 
user can give transverse stress in a selected point. 
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Naming of a point will allow easier further control of stresses in a cross 
section. After naming all points in a drawing, numbers will appear on every 
point. 

 
By double clicking on a line, WinAqua will select a line and “line property” 
window will appear. Here user can define material and name of the selected 
line. 
 

          

 Single reinforcement 
 
By activating the command for “Single reinforcement”, WinAqua will ask the 
user to input coordinate for single reinforcement. Coordinate can be define 
by clicking in the drawing area or by typing global y,z coordinates in a 
command window. After inputting the coordinate “Bewehrungspunkt”, 
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window will appear in which the user can define the name of reinforcement, 
material for reinforcement, layer, coordinate etc. 
 

 
 
For more detailed description for other parameters (reinforcement area, 
max. reinforcement area, reference area, pre-stress, torsion effect, 
diameter etc.) see aqua manual paragraph 3.37. Reinforcement. 
For Example 1 user can activate the command “Single reinforcement” and 
can define single reinforcement with the appropriate parameters given in 
Table 1.2. 
Command: 
New Single reinforcement [m] -0.105, -0.105 
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New Single reinforcement [m] -0.320,0.077 
 

 
 

 

 Shear cut 
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By activating the command for “Shear cut”, WinAqua will ask the user to 
input two coordinates, which will define a line (section) in where shear 
stresses will be analyzed. 
 
In Example 1 user should examine four shear cuts. The first two shear cuts 
will be parallel with y axe (with z coordinate z=-0.311 and z=-0.11). The 
next two shear cuts will be parallel with z axe (with y coordinate y= -
0.322448 and y=-0.55). 
Start the command “Shear cut”, WinAqua will ask the user for the first and 
last point of the shear cut line. 
Command: 
New shear cut, first point [m] 0.32,-0.31 
New shear cut, next point [m] -0.75,-0.31 
[Press ESC to end the command or press right mouse button and select 
Abort command]  
Double click drown line, line properties window will appear. 
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Here user can define some control parameters for shear cut calculation. 
More details for these parameters can be found in aqua manual in 
paragraph 3.28. CUT - Shear Sections  
The same way as mentioned above the rest of the shear cut will be inserted 
in WinAqua drawing. 

 
 

1.2.6. Saving database  
 
From the “File” menu select options in “Save”. 
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Standard save-as window will appear. Give the name and define the path in 
which database should be saved. WinAqua will create database file 
name.cdb in the selected path. 
 

1.2.7. Calculating cross section 
 
From the “File” menu select options in “Calculate”. If you have defined more 
then one cross section in the same database then you can select option 
“Calculate all”. 

 
 
WinAqua will do the calculation for the section and the result will be stored 
in the name.cdb database. If you want to check the result double-click on 
the section in a database window. As it was described, “Section tick walled” 
window will appear. Select “Values” tab to view result of calculation. 
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Now file name.cdb is ready for further use in SOFiSTiK static calculation. 
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2. Freely defined solid with circle holes 
 
A freely defined solid cross-section consists of any number of outer and 
inner perimeters in the form of circles or polygons, as well as of 
reinforcement elements. Structural steel shapes can be integrated. The 
Example 2 is consisted of two outer (plate) and three inner (circles) 
perimeters. 
In this example a composite cross section made of prefabricated plate with 
three holes and in site cast plate should be created. 
 

2.1.  Concrete Reinforcement 
 

11 16 11 16 11 16 11
19 27 27 19

92

20 2020
16 34

17
17

9
9

C30(EC2)

C40(EC2) area=10cm  ;O102

area=10cm  ;O102

area=10cm  ;O202

 
 
 
 
 

2.2. Solving the problem with WinAqua 
 

2.2.1. Default property setting 
 
When the new project is stated, WinAqua created by default a dtabase 
named “Untitled_1” with two predefined materials: B 25 (DIN 1045) and 
BST 500 (DIN 1045). 

 
 
This option can be changed with the command Settings 
 
Menu: Extras→Settings 
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The “Options” window appears on the screen and the user can choose one 
of the four options to generate the default materials in new database. 
 

 
 
With the help of the “Options” windows the user can change several default 
properties also. Clicking on the command button Structural Steelwork 
(SI)[mm] input units can be changed. The new window Dimensions appears 
on the screen and the user can choose between several System and Model 
units described in Example 2. 
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The tab “Color Definitions” of the “Options” window, gives the opportunity 
some property of the graphical entities to be changed.  
 

 
 

For example, clicking on the picture Couture, the Line Style and the color of 
the contour can be changed. 
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The Tab page General is used for setting the language, toolbars that will be 
showed on the screen, saving interval, coordinate latency, picking size, 
current font in protocol view, screen and printer defaults. 
 

 
 
 

2.2.2. Material definition 
 
The process of crating a new section begins with definition of the materials. 
The section is made of three materials: (EC2) Standard Concrete 
Classification 30 and 40, and (EC2) Standard reinforcement Steel 
Classification 500. At the beginning the property of the material 1 will be 
change. Double click on the name of the material 1 opens the SOFiSTiK 
“Material” window. 
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In the combo boxes “Design Code”, the “Euro code” standard should be 
selected. The type is set to “(EC2) Standard Concrete” and Classification 
is set to 30. 
 

 
 
In a similar way the property of the material 2 will be changed to “(EC2) 
Standard” and the reinforcement to “Steel Classification 500”. 
New material in the database can be added using command  
 
 Menu: Edit→→→→New material… or  
 Icon:       New material 
 
The (EC2) Standard Concrete, Classification 40 will be selected to the 
material 3 
 

2.2.3. Section creation 
 
The new section can be added to database with the command 

 Menu: Edit→→→→New section 
There are several options to create the new section: standard, “thinwalled” 
and “thick walled” type. In this example the “thick walled” type should be 
selected. Firstly the plate with three holes will be created. 
The contour of the cross section should be drawn with command 

 Menu: Section→→→→Contour 
 Icon:        Contour 
The contour’s point can be input by mouse or by typing in the command 
window.  
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Command: 
 
New polygon, first point [cm]: 0,0 
New polygon, next point [cm]: @0,-34 
New polygon, next point [cm]: @92,0 
New polygon, next point [cm]: @0,34  

[Press ESC to close the couture or press right mouse button and 
select Close command]  
 
The material property for this contour can be set by double mouse click 
over contour, or by right mouse click and choose the item Properties… from 
the floating menu. 

 
In the next steps several help line should be created. At first, two help lines 
that connect the mid points of the opposite sides of the plate should be 
created. The command  

 
Menu: Section→→→→Help line 
Icon: Help line 

draws the construction line between two points. The temporary “object 
snap” toolbar can be used for precisely definition of the mid points on the 
line. 
The Move command is used to change the position of some object or to 
make a copy of the same.  
 
With the Move icon      from toolbar “Selection”                                , the 
vertical help line should be offset on the distance 27 cm. At first the vertical 
line should be selected by pointing with the mouse on it. After that the Move 
command is started 
 
Command:  
 
Form point:  
 
[Select intersection between vertical and horizontal mid line] 
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To point:@27,0 
 
Delete old element <1>yes <2> no (2):2         [not delete the original] 
 
The prefix  “@” is used to set coordinate relatively to the last drawn point. 

 
Mirroring the previously created line, the last help line should be created. 
The mirroring process begins with selection of the line that should be 
mirrored and activating the command Mirror      from toolbar Selection. 
Command:  
First point of axis or axis [cm]:    
[select the first point of the mirror axis “that is bottom point of the first drawn 
help line”] 
 
End point of the axis [cm]:   
 
[select the second point of the mirror axis “that is upper point of the first 
drawn help line”]  
 
Delete old element <1>yes <2> no (2):2         [not delete the original] 

There are several ways to create hole in the section. One is to use  

Menu: Section→→→→Hole (circle) 
Icon:   Hole (circle) 

Another way is by clicking on the screen with the right mouse button. The 
floating menu appears 

 
Selecting  

New→→→→Hole(Circle) 
the process of creating the new hole started. In the our example the three 
holes are created as a follow 

Command: 
Center Point for circle [m]: 19,-17  [center of hole] 
Point on radius [m]: 19,-25   [radius 8] 
Segments <10>:    [Press Entry to accept this] 
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Center Point for circle [m]: 46,-17    
Point on radius [m]: 46-,25    
Segments <10>:  
Center Point for circle [m]: 73,17    
Point on radius [m]: 73,25    
Segments <10>:  

The plate cross section with three circle holes was created. 

 
2.2.4. Reinforcement setting 

 
The top and bottom reinforcements are presented with as distributed line of 
reinforcement. They can be insert in the section by command 
 

Menu: Section→→→→Line of reinforcement 
Icon:  Line of reinforcement   
 

In our example two line of reinforcement should be set.  
Command:  

New line of reinforcement, start point [m]: 4,-4 
 

New line of reinforcement, end point  [m]: @84,0 
New line of reinforcement, end point  [m]: 
 [Press Enter to not start next segment] 
 
Chose reference point:     
[Press Entry to not start next line by ref.] 
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When the line of reinforcement is drawn, a Line property window appears 
on the screen 

 
 
The reinforcement’s name, area and diameter should be inserted in the 
appropriate text boxes.  
In a similar way the second line of the reinforcement is inserted in the 
section. 
 
Command:  
 
New line of reinforcement, start point [m]: 30,4 
New line of reinforcement, end point  [m]: @88,0 
New line of reinforcement, end point  [m]:      [Press Entry to not start next 
segment] 
 
Chose reference point:  [Press Entry to not start next line by ref.] 
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2.2.5. Upper part of the cross section 

 
To create the upper pert of the cross section a new contour should be 
drawn. 

 Menu:  Section→→→→Contour 
 Icon:  Contour 
 
A four-point contour is drawn. 
Command: 
New polygon, first point [cm]:0,0 
New polygon, next point [cm]:@0,-20 
New polygon, next point [cm]:@92,0 
New polygon, next point [cm]:@0,20  

[Press ESC to close the couture or press right mouse button and 
select Close command]  
The new contour inherits the default property of the cross section. In this 
case the material number is 3 C40 [EC 2]. The material property can be 
change with right click over one of the contour segments, and from floating 
menu the item “Property…” should be selected  
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The Section “thick walled” window appears on the screen 

 

 
 

In the combo box Material the appropriate material 1 C 30 (EC 2) should be 
selected. 
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At the end the line of reinforcement, named Bottom layer 2, with area 10 
and diameter 10 is drawn. 
 

 
 
2.2.6. Control points 

Stress location points 
Resistance module for all stresses is only available at distinct points of the 
cross-section. Two points for stress calculation will be defined: point 101 
placed at the middle of the upper cross section’s edge and point 102 placed 
at the middle of the down edge. 

 Menu: Section→→→→Stress location 
 Icon:  Stress location 

Command: 

 
New stress location point [cm]:0,-10  [use the temporary object snap toolbar 
to point middle of the upper and down edges or input the coordinates of the 
points] 

The Stress location window appears on the screen.  
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The Name should be set to 101. Entering the coordinates of the next points 
should continue the process. 

Command: 
New stress location point [cm]: 0,-44  
New stress location point [cm]:        
[Press Entry two times to stop entering] 
All the points entered by one Stress location command should have the 
same name, in our example 101. The number, the material and the location 
of the points can be changed with double click on the point. To change the 
number of the down point, double click on the point. The Stress location 
window will appear and the number and the material should be change. 
 

2.2.7. Shear Cuts 
 

The user uses the command CUT to define a so-called cut through the 
sectional geometry where a check of the shear stresses should take place. 
Each cut is assigned identification with three characters. The cut can be 
defined as parallel to an axis or as a freeform polygon line. Every segment 
has its own material number and it will cut only through cross-section 
elements with the same material number. Gaps between the segments will 
be closed by means of virtual connections. A width of the substitute 
torsional cross-section is available as a special option for the description of 
equivalent hollow cross-sections of reinforced and pre-stressed concrete. 
Two partial cuts are generated for each section in this case. 
If the user does not supply any input, one or two axis-parallel cuts will be 
created through the gravity center. This generally is not sufficient even for a 
simple T-Beam, or for composite sections, where the reference material 
number of the section is not necessarily represented at that location. The 
user will see a warning for general sections therefore. 
 
In the Example 2, one shear cut section will be defined. It will split the cross 
section through the centers of the holes. 

 Menu:  Section→→→→Shear cut 
 Icon:   Shear cut 
 

Command: 
 
New shear cut, first point [cm]: -50,-27 
New shear cut, first point [cm]: 50,-27 
New shear cut, first point [cm]:    
 
[Press Esc to stop entering] 
 



 

WinAqua Version 10.21-99 40 

The shear cut section should be named. Double click on the shear cut 
section opens the Line property window that allows the user to enter or 
change the name and some other properties. 

 
 

The effects of the last two commands are shown on the figure that follows. 

 

2.2.8. Calculation – cross section property 
 
After section creation, the cross section properties should be calculated. 
There are to commands that calculate cross section properties.  

• Calculate - only the property of the actual cross section will be 
calculated 
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• Calculate all  - all sections in the database will be calculated 
In this example the command Calculate is activate and the property of the 
cross section are calculated. The results of the calculation are shown at the 
following 
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2.2.9. Using already defined cross section 
 
Already defined cross section can be used in the process of creating the 
new section. Using Cut and Paste command one can simplify creation of 
the new section that has similar form with already defined sections. In this 
example the same cross section will be created using previously defined 
cross sections. 
 
Step 1 - The down part of the cross section (plate with holes) 
The standard plate cross section will be use to start creation of this part. 

Menu: Edit→→→→New section (standard)… 
Icon:  New section (standard) 
 

The General Cross-Section window appears on the screen. 
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The number of selection is set to 1. After selections of the plate type the 
window SOFiSTiK: Plate Section will be ready to accept the property of the 
section 

 
 
Some of the properties should be changed: 
 

Material:   [3 C 40 (EC2)] 
Height:   34 
Width:   92 
 
Position of origin: Top center 
Reinforcement 

 
Distance  Area  Diameter 

Top  4   10  12 
Bottom  4   20  20 

The other parameters should remain unchanged. 
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The section appears in the graphical area of the WinAqua environment. 

 
 

In the similar way the upper part of the section is created 
 
Menu: Edit→→→→New section (standard)… 
Icon: New section (standard) 
 

 



 

WinAqua Version 10.21-99 45 

The general cross section Plate should be selected. 

 
Same of the property should be changed: 
 

Material:   [1 C 30 (EC2)] 
Height:   20 
Width:   92 
Position of origin: Bottom center 
 
Reinforcement 
  Distance Area  Diameter 
Top  2  0  28 
Bottom  3  10  12 
 

The upper part of the section is created. 

 
In the next step the standard cross sections, previously created, will be 
used to create the composite section of the Example 2. 
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New section type “thick walled” should be started. 

Menu: Edit→→→→New section (thick walled)… 
Icon:  New section (thick walled) 

Using “Copy” and “Paste”, the standard sections will be copied into the new 
thick walled section. In the Database, section 1 should be selected. 
 

 
 
Using the icon Select with box , from the toolbar Selection 

                        the cross section will be selected. If the Selection 
toolbar is not active, one of the graphical objects should be select (simply 
mouse click). That will made the Selection toolbar active. Pressing the icon 
copy      will put the selected section into the clipboard. In this moment a 
window dialog box will appears on the screen 

 

 
 

The “Yes” command button should be pressed to convert the standard 
section into an editable section. After that the content of the clipboard 
should be pasted into the section 3.  

 Select the section 3 in the Database 
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 Paste the clipboard into the graphical editor. 
During the “Copy” and “Paste” process some properties of the standard 
cross section should be missed. The contour of the cross section should be 
turned in the help line. 

 
 
The user must once again to draw the contour of the plate and set their 
property.  

 Menu:    Section→→→→Contour 
 Icon:       Contour 

The contour of the down plate should be redrawn over the help line.  

Help line 
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In the next steps the material for that contour should be set. Double click on 
one of the contour’s segment will activate the Line properties windows. 
Sometimes WinAqua selects the help line instead of contour. In that case 
after drawing the contour one help line should be erased and the contour’s 
segment that pass over this line should be selected. 
 

 
 
In the Material combo appropriate material is selected. 
The process repeats with upper part of the section 
At the end the three holes should be inserted into the section using the 
standard procedure. 
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3. T-beam 
 
The program WinAqua should create two T-beam cross sections. 
Geometrical characteristics of the first T-beam section are given on the 
Fig.3.1. Second T-beam section is given on the Fig.3.2 and this section has 
the same geometrical characteristics as the first section but here we will 
have non-effective part on the flange. Both sections are made of B55 
concrete and standard reinforcement BST 500. The position of the 
reinforcement is shown on the Fig.3.3 for the first T-beam section and on 
the Fig.3.4 for a second cross section. 
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Fig. 3-1T-Beam section Fig. 3-2 T-Beam section with non-effective part 
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Fig. 3-3 Reinforcement    Fig. 3-4 Reinforcement 

 
Section shown on the Fig.3.1 will be drawn using “standard cross 
sections” from WinAqua. Because of that user do not need to do some 
previous preparations for drawing units. By default WinAqua will set units to 
meters [m] from the SI system for this section. 
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To draw section shown on the Fig.3.2 coordinate beginning will be taken as 
it is shown on Fig.3.5. The Cross section is symmetric so we will use mirror 
option to draw symmetrical part of a section. We will select and use units’ 
centimeters [cm] from the SI system for this section. 
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x Section point 
x Reinforcement point 
 Contour of a section 
 Contour which will be drawn with mirror command 
 Axes 

Fig. 3-5 Position of the drawing 
The coordinates of the points with which the geometry of the T-beam 
section is defined are given in the Table 2.1, and the coordinates of the 
points with which the line reinforcement is defined are given in the Table 2.2 

Table 3-1 Table 3-2 
 
 

 
 
 
 
 
 

 
 
 

 

Coordinate Point Y Z 
1 0 0 
2 40 0 
3 50 0 
4 50 20 
5 40 20 
6 10 20 
7 10 100 

Coordinate As Point Y Z cm2 

101 8 5 
102 -8 5 125 

103 8 95 
104 -8 95 62.5 
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3.1. Solving the problem with WinAqua 

 
3.1.1. Defining default units and materials in database file  

(and creating a new database file) 
 
This step was described in details in Example 1. For section shown on 
Fig2.1 we will use standard WinAqua section and for this option there is no 
need to define the units because the option uses default units meters [m].  
Do not forget to change default materials form B 25 to B 55 as it was 
described in step 2 from Example 1. 
 

3.1.2. Drawing section 1  
(shown on Fig2.1) using standard sections 

 
From menu “Edit” select “New section [standard]…” or select        icon 
from toolbar “CDBase Toolbar”. 

 

 
 

WinAqua will open a new “General Cross-sections” window. User 
can here define number “No” of the 
cross section, with which section will be 
stored in a database. User selects the 
type of a section. Depending on a 
selected type, different window will 
appear after pressing button “OK”. For 
Example 2 user should select “T-Beam 
section”. A new window will appear 
which will help user to define geometry 
of the T-beam section. 
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To define geometry of a section see Fig2.6. 
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Fig. 3-6 Parameters for defining T-Beam section 
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From this option user can select 
the type of material for the 

section. In this list box only materials previously defined in step 1 will be 
stored. 
 

 
Parameters for defining T-beam 
geometry 
 
 

Using Invert T-beam 

 

           
Using position of origin 

 

Center of gravity Top right Top left  

     
Top center Right Left  

       
Bottom center Bottom right Bottom left  
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Plate center Plate right Plate left  

      
For more details about other options in this window see Aqua manual 
paragraph 3.17. SREC - Rectangle, T-beam, Plate. 

 
Linear reinforcement is automatically defined with the parameters, which 
were given in the Cross section T-beam window. 

Note: “Edit section toolbar” is unavailable if you create a section using 
“Standard cross section”. 
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3.1.3. Drawing section 2  
 

(shown on Fig3.2) using thick walled section 
 

From Edit menu select “New section [thick walled]…”. Set text box 
“Number” to 2 and set section name to “T-beam with reduced flange”. 

 
 

Click on the button by the “Inputs” and select units [cm] as it is shown on 
the next figure. 

 
A new drawing area will be opened ready for inputting a new thick wall 
section. 

Start the command “Couture” from the menu “Selection” or by selecting     
icon form “Edit section” toolbar. Enter the coordinates for section 2 given in 
Table 2.1. 
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Command: 
 
New Polygon, first point [cm] 0,0 
New Polygon, next point [cm] 40,0 
New Polygon, next point [cm] 50,0 
New Polygon, next point [cm] 50,20 
New Polygon, next point [cm] 40,20 
New Polygon, next point [cm] 10,20 
New Polygon, next point [cm] 10,100 

[Press right mouse button and select Mirror all points ] 
WinAqua will ask you to define the mirror line 

First point of axes or axes [cm] 0,0 
Last point of axes or axes [cm] 0,100 
Command: 
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3.1.4. Defining non-effective part of a section 
 
To defining non-effective part of a section select the menu “Section” and 
select “Non-effective parts” command or select  
icon from Edit section toolbar. 

 
 
 
 
 
 
 
 

 
 
 
 
 
WinAqua will ask from the user to define rectangular area where the non-
effective area is placed. Non-effective rectangular area is defined with two 
diagonal points (defining diagonal of a rectangular) see Fig 3.7.  

123

4 5 6

 
Fig. 3-7 

There are two ways to define non-effective area. User can define non-
effective area by giving the coordinates with clicking the mouse in a drawing 
area, or by typing the coordinates in the command window. 

User will define the first non-effective area (on the left side of flange) in this 
example by using the mouse and for the second non-effective area (on the 
right side of flange) user will define it using the coordinates typed on the 
command window. 
 

3.1.4.1. - First non-effective area on the right side of flange 
 
Start the command “Non-effective parts” as it was described above. 
Activate “end point” snap from “temporary object snap” toolbar or by 
pressing F3 key. Approach with the mouse towards the point 4 in a 
WinAqua drawing. Press the left mouse button and WinAqua will 
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automatically place the first corner of non-effective area in the point 4. 
Activate “end point” snap again and approach towards point 2. Press the 
right mouse button again and WinAqua will define the last point of non-
effective area. 
 

3.1.4.2. - Second non-effective area on the left side of 
flange 

 
Start the command “Non-effective parts” as it was described above. In 
command prompt type the coordinates of the point 5’ and after that 
coordinates of the point 3’. 

Command: 
New noneffective width, start point [cm] –40,20 
New noneffective width, end point [cm] –50,0 
 
This is the second way to define non-effective parts of a cross section. 
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3.1.5. Defining linear reinforcement 

 

To define linear reinforcement use the command “Single reinforcement” 
from menu “Section” or click on the     icon from the “Edit section” toolbar. 

 
 

Linear reinforcement is defined with coordinates of the two points (at the 
beginning and in the end of linear reinforcement line). User can enter these 
coordinates by typing them in the command line or by clicking with the 
mouse in the drawing area. 
Start the command “Linear reinforcement” as it was described above. 
Enter the coordinate given in the Table 2.1. 
Command: 
New line of reinforcement, start point [cm] 8,5 
New line of reinforcement, start point [cm] -8,5 
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A window will appear that will ask the user to define the name of the 
reinforcement line (which will be used in further stress and reinforcement 
analyses), Reinforcement area [cm2/m], Diameter etc. 

 
 
For more detailed description of parameters in this window see aqua 
manual paragraph 3.37. Reinforcement. 
In the same way linear reinforcement will be defined at the bottom section. 

 
3.1.6. Saving and calculating section database 

(This step was described in step 5 and 6 in Example 1.) 

Note: For calculation use the command “calculate all”. This way the 
section 1 and section 2 will be calculated. If user uses the command 
“calculate”, then only the active section will be calculated. 
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4. Thin-walled steel box 
 
A twin walled non-symmetric steel box with different plate thickness is 
examined. Geometrical characteristics of the thin walled steel box are given 
on the Fig.4.1. The section is made of structural steel S37 (DIN 17100). 
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(t- thick of a thin wall element)  Fig. 4-1Cross section 
 
For this section user should define coordinate beginning and all 
characteristic points that define thin-walled steel box. For this example we 
will select and use units’ meters [m] from the SI system for this section. In 
WinAqua thin-walled steel box will be defined as it is shown on the Fig4.2. 
For easier stress analysis we recommend you to define name of a thin wall 
element as is shown on the Fig4.2. 
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The coordinates of the points with which the geometry of the T-beam 
section is defined are given in the Table 4.1 
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Fig. 4-2 

 
Table 4-1 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Coordinate Element Point Y Z 
1 -0.16 0.00 101 2 0.00 0. 00 
2 0.00 0. 00 102 3 0.16 0. 00 
3 0.16 0. 00 103 4 0.56 0. 00 
4 0.56 0. 00 104 5 0.61 0. 00 
6 0.00 0.35 201 
7 0.16 0.35 
7 0.16 0.35 202 8 0.46 0.35 
2 0.00 0. 00 301 
6 0.00 0.35 
3 0.16 0. 00 302 7 0.16 0.35 
4 0.56 0. 00 303 8 10 100 
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4.1. Solving the problem with WinAqua 
4.1.1. Defining default units and materials in database file  

(and creating a new data base file) 
 

This step was described in details in Example 1. 
 
Do not forget to change default materials from structural steel S 235 (DIN 
18800) to structural steel S 37 (DIN 17100) as it was described in step 2 
from Example 1. 
 

4.1.2. Drawing section using thinwalled sections 
 
From menu Edit select New section [thinwalled]… or select 

icon from toolbar CDBase Toolbar. 
 
 

 
WinAqua will ask the user to define two points (start point and end point of 
a thin walled element). Enter coordinate given in the Table 4.1. 

Command: 
New thin walled element, start point [m] –0.16,0 
New thin walled element, end point [m] 0,0 

A new window will appear asking the user to input name of a thin-walled 
element, thickens of a element. 
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Enter the name of the first thin walled element, as described in the Fig4.2 
(101) and input the thickens of a element as is was shown in the Fig4.1 
(0.016). 
 
Repeat this procedure for all element defined in table 4.1 
 

 
 

4.1.3. Saving and calculating section database 
This procedure was described in step 5 and 6 in Example 1. 
 

4.1.4. Exporting result in to plb file and using program Ursula 
 

For more detailed result reports user should use program “Ursula”. To use 
“Ursula” first you have to create “*.plb” file. With command “Export PLB 
file” WinAqua will create “name.plb” file by exporting already created 
“name.cdb” file. From “File” menu select command “Export PLB file”. 
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After activating command “Export PLB file” a new window “Export for 
Ursula” will appear. Here user can select export parameters. 

 
After creating file “name.plb” user can view the result in Ursula. From “File” 
menu select command “Start Ursula”. 

 
Program Ursula will start. 

 



 

WinAqua Version 10.21-99 66 

 
This is a detail report from all calculation made in WinAqua. 
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5. Polygonal box section  

 
The program WinAqua can be used to create polygonal box section as it is 
shown on the Fig.5.1 
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Fig. 5-1Cross section 

 

The polygonal box section is made of B25 concrete. User should analyze 
shear stress in four characteristic cuts as shown on the Fig.5.2. 

75

 
Fig. 5-2 Position of shear cut 



 

WinAqua Version 10.21-99 68 

The section will be oriented as shown on the Fig5.3 

+z  
Fig. 5-3 Orientation of the cross section 

 
For this example user should use units meters [m] from the SI system. To 
define geometry in WinAqua, program AutoCAD2000 will be used. User 
should draw section in AutoCAD in y-z plane as shown on the Fig5.4. All 
units must be in meters [m]. 

 
Fig. 5-4 Cross section in AutoCAD 

 

This drawing should be exported in dxf file. Procedure for exporting 
AutoCAD drawing in dxf file is: 

- From “File” menu  select “Save As”. 
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- Select a name for exported drawing (for example DXF input) and 
select “AutoCAD 2000 DXF (*.dxf)”save as type. 

 
 

5.1. Solving the problem with WinAqua 
 

5.1.1. Drawing polygonal box section in WinAqua 
 
After creating database file from the “Edit” menu select “New section[ 
thick walled]…” or select      icon from CDBase Toolbar 
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A new item will appear in database window under “Section” folder. Point 
with the mouse on a section name in database window and click on the 
right mouse button. A new floating menu will appear. Select command  
“Load section from DXF” 

 
 
Warning message will appear. WinAqua warns user that all previously 
drawn line in selected section from database will be deleted. 
 

 
 

Import command will be canceled if user selects “No”.If button “Yes”is 
selected WinAqua will ask for path and name of dxf file. Find and select 
previously created “DXF input.dxf” file. 
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WinAqua will draw section in the drawing window using help lines. 
Note: Command “Load section from DXF” is available only for “thick-walled” 
sections! 

 
Position and orientation of a section in WinAqua will be the same as it was 
defined in AutoCAD. The section will be drawn whit help lines. 
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To define section suitable for calculation user should define section by 
using “contour” command and appropriate snap. Help line will help user for 
easier defining outer contour of the section. 
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5.1.2. Defining inner contour of a polygon box section. 

 
Using “Hole” command user can define the inner contour of the section. 
From the “Section” menu select command  “Hole” or select      icon from 
“Edit section” toolbar. 
 
 

 
  
 
 
 

 
 

 
 
 
 
 
 
 
 
 
 

This command works exactly like 
command “Contour” as previously 

described in Example 1 in step 4. Use snap and command “Hole” to define 
inner contour of a section. 

 
 



 

WinAqua Version 10.21-99 74 

5.1.3.  Defining shear cut 
 
This procedure was described in step 2 paragraph “Shear cut” in Example 
1. 

 
 

5.1.4. Saving and calculating section database 
This procedure was described in step 5 and 6 in Example 1. 

 
5.1.5. Exporting result in to plb file and using program Ursula 

This procedure was described in step 4 in Example 4. 
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6. Composite Section 
 
The program WinAqua can be used for creating composite section. With 
WinAqua a square steel shape with concrete core should be made. 
Geometry of this composite section is as shown on the Fig.6.1. 
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Fig. 6-1 Cross section 

Material from which this section is made is given on the Fig.6.1. In WinAqua 
the section will be oriented as is shown on the Fig.6.2. 
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Fig. 6-2 Orientation of the section 

 
The main geometry of this section is defined with coordinates are given in 
Table 6.1. 
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Table 6-1 
 
 
 
 
 
 
 
 
 
 
 

Note: The sectional values can refer to steel or concrete material. For 
example, the area can be calculated: 

� If section values refer to steel material 
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� If section values refer to concrete material 
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Coordinate Point Y Z 
1  0.15 -0.15 
1’ -0.15 -0.15 
2 0.15 0.15 
2’ -0.15 0.15 
3 0.14 -0.14 
3’ -0.14 -0.14 
4 0.14 0.14 
4’ -0.14 0.14 
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6.1. Solving the problem with WinAqua 

 
6.1.1. Drawing composite section in WinAqua 

 
Create new database and import two materials (B25 and ST 37) for the 
composite section. From the “Edit” menu select “New section[thick 
walled]…” . Before starting to draw the section user should define current 
material for the section. Double click on the section name in the “Section” 
folder from “Database” window. 

 
“Section Thick walled” window will upper. 
 

     
 
Set current material to “2 ST 37(DIN 17100)”. Note list box for reinforcement 
and stirrup is empty because there is no reinforcement in this section. After 
defining the default material user should draw outer (steel) contour of the 
section using command “Contour”. To complete steel part of the section 
user should activate command “Hole” and draw inner contour of the 
section. 
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Start command “Contour” 
 

Command: 
New Polygon, first point [m] 0.15,0.15 
New Polygon, next point [m] 0.15,-0.15 
[Press right mouse button and select command Mirror all points]  
first point of axis or axis [m] 0,0 
last point of axis or axis [m] 0,0.15 
Outer (steel) couture of the composite section will be drawn. 

Start command “Hole” 

Command: 
New hole, first point [m] 0.14,0.14 
New hole, next point [m] 0.14,-0.14 
[Press right mouse button and select command Mirror all points]  
first point of axis or axis [m] 0,0 
last point of axis or axis [m] 0,0.15 

As it was previously described prepare drawing area for drawing concrete 
part of a composite section by setting current material to “1 B 25(DIN 
1045)”. 

 
To complete all composite section user should activate command 
“Contour” and draw contour of the concrete part of the section. 

Start command “Contour” 

Command: 
New Polygon, first point [m] 0.14,0.14 
New Polygon, next point [m] 0.14,-0.14 
[Press right mouse button and select command Mirror all points]  
first point of axis or axis [m] 0,0 
last point of axis or axis [m] 0,0.15 

Save database and the section is prepared for calculation. 
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6.1.2.  Calculating composite section  
 
For calculating section values user should set to which material the section 
value will refer to. This operation can be done using current material.  
If current material is “1 B 25(DIN 1045)” concrete sectional values will refer 
to the concrete. 
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If current material is “2 ST 37(DIN 17100)” steel sectional values will refer to 
the steel. 
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6.2. Composite Section (steel profile + concrete plate) 
The program WinAqua can be used to create composite section that is 
made of steel profiles and concrete sections as shown on the Fig.6.3. 
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Fig. 6-3 Cross section 

 

 

Materials from which this sections are made are given on the Fig.6.3. In 
WinAqua the section will be oriented as shown on the Fig.6.4 
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Fig. 6-4 Orientation of the section 

 

The main geometry of this section is defined with coordinates given in Table 
6.2. 
 
Table 6-2 

 
 
 
 
 
 

Coordinate Point Y Z 
1  0.5 -0.25 
2 0.5 -0.15 
3 0.075 -0.15 
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6.3. Solving the problem with WinAqua 

 
6.3.1. Drawing composite section in WinAqua 

 

Create a new database and import two materials (B25 and ST 37) for the 
composite section. The “Section Thick walled” should be created in the 
database. To import steel shape section user should use “Steelshape” 
command from “Selection” menu. This command can be run from the icon 

       placed in “Edit section” toolbar, too.  

 
 

After starting “Steel shape” command “Profile” window will appear. 
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All parameters that define steel profile can be set in this window: 

Title: Here user defines a profile name. WinAqua automatically gives a 
name in the title text box (depending on the selected profile). 

Material: From this list box user can select and set structural steel material 
for steel profile. If there is no structural steel material defined in the 
database then this list box will be empty, so WinAqua cannot create steel 
profile! 

Type: With this option user can select type and dimension of a steel profile 
(IPE,HEA,HEB,HEM,U,I etc.) 

Reference point: With reference point WinAqua defines base point for 
inserting the profile. For example, if reference point is top center then base 
point for placement of a section will be as shown on the next figure. 

Cursor 
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If reference point is set to center of gravity then base point for placement of 
a section will be as shown on the next figure. 

 

Cursor 



 

WinAqua Version 10.21-99 87 

Angle: Defines angle of the section. 

If the Angle=0o then WinAqua will insert section as it is shown on the next 
figure. 

 
If the Angle=45o then WinAqua will insert section as it is shown on the next 
figure. 

 
 

Buckling curve: User can set buckling curve for selected profile (D, A/B, 
B/C, C/D). Usually WinAqua automatically sets buckling curve when user 
selects appropriate steel profile. 

 

Option Custom: This option gives user opportunity to define his own 
dimension for the steel profile. 
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Option button “full” and “half” 
If the option button is set to “full” then WinAqua will import a full steel 
profile. If the option button is set to “half” then WinAqua will import a half 
steel profile as it is shown on the next figure. 

 

    
 
Button static value: This button gives the main elastic and plastic 
geometric characteristics for the selected profile. 

 

 

By clicking on the button “OK” WinAqua will ask the user to define the 
position point for the steel profile. 
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In this example user should select profile IPE300 with base point “center of 
gravity” and he has to place the profile in a coordinate 0,0. 

Drawing concrete plate will be done by using  “Contour” command. 

Command: 
New Polygon, first point [m] 0.5,-0.25 
New Polygon, next point [m] 0.5,-0.15 
New Polygon, next point [m] 0.075,-0.15 
 [Press right mouse button and select command Mirror all points]  
first point of axis or axis [m] 0,0 
last point of axis or axis [m] 0,0.15 

 
The calculation process will be same as it was explained in Example 6, 
paragraph 6.1 Composite Section (step 2). 
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